TV Slide Show Studio

Thank you for purchasing and installing TV Slide Show Studio from Abacus Software. You'll soon discover
just how easy it is to make your own video memories to share with your friends and family on-line, on CD-
ROM or on DVD. Be sure to visit www.abacuspub.com for the latest software and program information

Here we'll cover the basics to help you get started. There are some sample pictures found on the CD-ROM in
folder called Samples. You can use these to practice on and follow along. Start TV Slideshow Studio using the
TV Slideshow Studio icon on your Desktop, or through the Start | Programs | Abacus | TV Slideshow Studio
menu.

Screen layout and area discussion

When you first open your TV Slideshow Studio you will notice 6 main areas of the screen. Each of these areas
is labeled in on the image below.
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1. Menu Bar This area contains buttons allowing you to start a new slideshow, open an existing slideshow,
save, adjust settings, export your slide show as an MPG, AVI or WMV, preview your slideshow in Full Screen
and access the Help menu. The far left of the Menu Bar holds the Storyboard view (shown above) and the
Burning screen, which controls the DVD chapter and menu setup.

2. Browser Pane This area is a standard explorer of the folders on your hard disk. Select the folder containing
your photos and/or music and thumbnails of these will appear in the central pane.

3. Thumbnail Pane The center area displays the list of photos and/or audio files available in the selected folder.
At the bottom of the Thumbnail Pane is a series of 5 tabs that will switch you to a different Thumbnail screen.
The transitions tab for example will show a thumbnail representation for each of the available transitions you
can place between your pictures.



4. Chapter Pane The bottom left pane is for creating chapters. Each chapter contains a series of photos, sounds
and transitions and each chapter produces a separate slide show. A complete presentation may consist of one or
several chapters. Each chapter is accessible from the DVD menus using you’re DVD remote control. By
default, there is one chapter.

5. Storyboard This is where you place photos, sound files, transitions and text, etc., in other words all the
elements needed to compose the slide show.

6. Preview The preview area allows you to play your slideshow including all music and transitions you may
have. It will also show a preview of any picture you click on from the Thumbnail Pane as well as a preview of
text styles, transitions and filters.



Getting started with your first Slide Show

In just a few short minutes, you’ll see how fast and easy it is to create your very own slideshow with your
pictures. The example we’ll use below is available for you to view if you like in the Samples folder on the CD-
ROM.

Step 1. Locate your pictures and name your album. Use the Browser Pane to locate your picture files. Our
example will show the contents of the Samples from the CD-ROM. Here’s what your screen should look like:

Use the Chapters Pane to rename your slideshow. By default, this is set to ‘Untitled’. Click on the Orange oval
labeled Untitled and press F2 to enter a new name for the Album. We’ll call ours “Veronica and Scott”. Press
enter to accept the new title.
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Step 2. Drag your pictures from the Thumbnail Pane, to the Storyboard. Click and drag a picture using the left
mouse button. Place the mouse over the Storyboard Pane and release the mouse button. You’ve just added your
first photo to your new slideshow!
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Continue to drag pictures from the Thumbnail Pane to the Storyboard until all the pictures you want in your
slideshow are in place.

HINT: To select more than one picture, hold the CTRL key down and click on each picture you want to add one
time. When they are all selected, release the CTRL key, then left-click/drag them to the Storyboard.

Here's what it will look like with all the pictures added.

At any time, click the triangle button (play button) below the Preview Pane to watch your slide show. To
change the length of time the image is displayed, you can RIGHT-click the image and choose Properties from
the pop-up menu. You can increase or decrease the number of seconds the image will be displayed.



This is a good time to save your work. Click the File menu located above the Menu Bar at the top and choose
Save As. Enter a name for your slideshow and select a folder to save it in. We’ve called ours “Veronica and
Scott”

Step 3. Adding Text. We’ll add some simple text that scrolls from the right to the left. Click the Texts tab below

the Thumbnail Pane.

Notice the screen is filled with new icons. Each icon allows a way to present the text. The short description
below the icon tells you what the text will do. Also, watch the Preview Pane on the right for a simple example.

Click and drag the Enter Right, Out Left icon onto the desired picture in your slideshow. We’ll place it on the
first one for our example, but it can be placed on any image — or all images! Once you release the mouse button
on the image in your Storyboard, you’ll be presented with the Text Properties window. Here you can enter the
desired text and position it anywhere on the image you want.

To follow our example, follow these steps:

1. Text set to Veronica and Scott

2. Set the size to 40

3. Set the font to “Balloon” from the drop down list

4. Set the Color to yellow by clicking the box below the word Color

5. Turn on 3D text by clicking the box

6. Set the Shadow Color to red and the Border Color to black

7. Adjust the slider to the left of the image to have the text scroll across the bottom of the image.

Text properties
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Once the Text Properties are set, click OK. Notice the letter T added next to the picture on the Storyboard. This
lets you know the picture has text applied to it. Click the play button on the preview to see the new text.
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Step 4. Transitions. Click on the Transitions tab, located next to the Texts tab below the Thumbnail Pane.
Similar to the Texts screen, the Transitions again show you a thumbnail of the available transitions. These
transitions go between the images. To choose specific transitions, simply drag them to the storyboard as you
would a picture. Release the mouse button when your pointer is on the small box between the images. The
image below show you the Fade transition placed between the first and second images.
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You can repeat this process for each transition. To quickly add random transitions between all images in your
slide show, RIGHT-click the transition square between any two images, then choose Randomly Fill In
Transitions from the pop-up menu. This will put in random transitions between all images. If you are not happy
with the random selections, you can simply drag a new transition in its place. We’ve added random transitions
to our slideshow example.
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To change the length of time the transition takes, RIGHT-click the transition square between the images and
choose Properties from the pop-up menu. You can increase or decrease the number of seconds the transition
will take. For dramatic effects, try using 5 second or longer transitions.

Step 5. Adding Music. Music can be added to your slideshow in a way similar to adding pictures. Browse to the
folder where the songs are kept, then drag it from the Thumbnail Pane to the bottom of the Storyboard. In our
Samples folder, we have an MP3 file. You’ll notice the icon is quite different than those of the pictures. Click
and drag the Piano_Upbeat.MP3 to the bottom of the Storyboard. Position your mouse point at the far left of the
Storyboard. You’ll notice a red line appears. This shows you where the music will start. You can have it start at
the beginning, or at any point during the slideshow. We’ll put ours at the beginning as shown.
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Once placed, you’ll see an orange bar below the storyboard. This represents the music. The white line in the
middle is a volume. Use your mouse to drag this line up or down to increase or decrease the volume from 0% to
200%. We find the music works best at about 135%.
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Also on the white line are Handles at the far left and far right of the bar (right side is off the screen). You can
click and drag the left handle to the right to set a fade-in for the music. The right handle can be moved to the left
to set a fade out. This make is very easy to cross-fade music.
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Below the orange line is another space for another audio track. If want more than one song to be played, simply
drag another music or audio file into the lower bar. You can place your mouse near the right handle of the first
song and drag the ending point of the music to the left. Then, you can position you second audio file to start
where the first left off. Use the Handles to set a cross fade if desired.

Finished! You have just created your very own slideshow! Click the Full Screen button on the Menu Bar to see
a full screen preview of your Slideshow. Once you are at full screen, press the Space Bar on your keyboard to
start the preview.

Note: The picture quality in the preview will be substantially lower than the actual version produced onto a
DVD or CD or as an MPG, AVI or WMV.

This is another good time to save. Click the File | Save menu to save your work!

Step 6. Exporting and Burning. The final step is to produce your video for others to see. You can produce your
slideshow in a computer-only format that can be posted on-line, or you burn your show directly to a DVD or
CD-ROM. Computer-Only formats include AVI, MPG and WMV.

To burn your slideshow to a disc, click the Burning button on the left side of the Menu Bar. The new screen will
be quite different from the Storyboard screen.
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The bottom of the window shows a set of pre-made chapter titles for your DVD’s root menu. Double-click a
selection from the list across the bottom and see the full screen version in the pane above.

Click the text “Untitled” at the top to customize the text, text size and text color. We’ve set ours to Veronica
and Scott and lowered the size to 70.

The right side of the window shows the information for creating a DVD. Start by entering a label (16 characters
or less). Next, choose the format you want to burn. The most common options are DVD and VCD. DVD is a
common DVD like a movie you’d buy at the store. VCD is a Video CD, which can hold 74 minutes of high-
quality compressed video and can be played on ‘most” DVD players. We’ve chosen DVD for our format. If you
do not have a DVD burner, then you can choose VCD as your format and can burn the slideshow to a CD-R.

The TV System is either NTSC or PAL. NTSC is the standard for the US and Canada, PAL is the standard for
Europe. If you’ll be viewing the DVD in the US, choose NTSC.

Unless you have more than one DVD or CD burner drive, you will not need to select the drive. CD-R users can
select the Speed if desired.

With a blank disk in the drive, click the Burn option and wait a few minutes for your slide show to be ready.
When it comes time to play your new DVD slideshow, you’ll need to use the DVD player’s remote control to
press the number 1 to start the show.



Quick Tip #1 - Adding a custom 'zoom' to a photo
p g p

You can easily add a custom zoom to your photo in a just a few simple steps:
1) Right click the photo and choose Move, then slide over and click ZOOM +. It will appear as though nothing
has happened. This is normal. You have just tagged the photo to have a zoom in effect.
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2) Right click the photo and again choose Move. This time, slide over and choose Properties.
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3) On the Properties window, click the box that reads Keep Ratio. Now, click and drag on the photo to select an
area of the photo. The area you select will be the final zoom position.

If you forget to the check the Keep Ratio box or you simply didn’t line up the area on the photo correctly, just
make sure the Keep Ratio box is checked and simply click and drag to select a new area. Our attempt took about

3 tries.
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4). Click OK and you’re all set! Be sure to click the Preview button to see how it looks. Instead of a zoom in,
you can zoom out in a similar way. Simply choose Zoom — from the pop-up menu. The area you select in the
properties will be the starting point and the zoom out will end at the full picture.



Quick Tip #2 - Adding a text-only title screen

You can insert a blank screen into your slideshow with custom text to introduce the next photo or series of
photos. To insert a title screen, follow these steps:

1) Click the Texts tab below the Thumbnail Pane.

2) Choose the type of text that you to be displayed on the title. In most cases you will want to use Base Title.
This a constant display of the text with no motion or fading.

3) Drag the Base Title text to the position before the image you want it to be displayed. This can be tricky
because the program allows you to also add the text to an image. Notice when dragging the text on top of
another image, the preview in the Storyboard turns to a negative image:

You want to position the mouse when dragging before the image as shown below. Notice there is a red line
drawn at the far left of the Storyboard:

4) Fill in the Text Properties screen. Here are the settings we chose:
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Here’s what it looks like now:
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5) Check your music! The music files you have added will stay at the same length they were before you added
the title screen. Click the Music bar to select it and scroll to the end of the Storyboard using the slider at the
bottom of the screen. Notice the Music stops before the end of the slideshow. This is because the music stayed
the same length, but you’ve added a new ‘frame’ to the Storyboard.

Place your mouse point at the end of the music bar. Notice the mouse icon will turn to a horizontal line. When it
does, click and drag to the right until the end of the music matches the end of the slideshow. Once you release
the mouse button, the slide show will reset itself back to the beginning of the audio file so you’ll have to scroll

to the end again.
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You can take this time to fade out to your music for best results.




Frequently Asked Questions
Q. When I add my MP3 audio file I seem to lose any changes to the slide show after I exit the program?

A. Most likely you are using a filename that contains special characters. Rename the MP3 file so that it has only
letters and/or numbers.

To rename a file you must first be able to locate the file. You can search for the file using the Start | Search
menu, or if you know where the file is located, use My Computer to open the folder where the file is. Right-
click on the file name and left click on Rename from the pop-up menu. Use the arrow keys and delete key to
edit the file name. Try to avoid any characters like the following:

~l@ASN & ()= [{<>,?

These limitations also apply to picture file names. If you have pictures from a digital camera, chances are your
file names are OK and will not need to be renamed. If you have scanned images, or images from another source,
you may need to edit those as well.

Q. How do I adjust the volume and fade?

A. To increase the volume of an audio file you first have to click on the audio track located below the
storyboard. When selected, the audio track will be orange and ready to edit. Drag the line that appears in the
center of the audio track upwards. To decrease the volume, drag the line downward.

For a fade, again, you have to have the audio track selected. Place your mouse on the far left side of the audio
track and you mouse pointer will turn to a horizontal line with an arrow at each end. There should also be a
small white square, called a Handle under the mouse icon. Click and drag the handle to the right for to fade the
music in. To fade out, drag the white handle on the far right of the audio track to the left.

You can also RIGHT-click the audio track and manually set the Fade In and Fade Out.

Q. It takes an extended period of time to view thumbnails of pictures I want to place in my video, is there
an easier way?

A. We always recommend creating numerous folders labeled specifically for your project. For example, we
place a folder for a subject that will be in the video, another folder for the other subject, etc. We also place
audio files in a separate folder and sometimes keep another audio folder for ‘works in progress’.

Q. It takes an extended period of time view the audio files I have, is there an easier way?

A. Please see recommendations above.

Q. What do I have to do to use only part of my audio file?

A. TV Slideshow Studio uses all audio files by starting with the beginning of the file. You will need an audio
editing program to edit your audio file by removing the parts you don’t want.

Q. What’s the best way to save my projects?

A. It’s a good idea to save your project incrementally. That is, when making major changes save the project and
also save a backup of the file by amending the name with the date or time.



Troubleshooting and Support

Keep posted to www.abacuspub.com for the latest info on TV Slideshow. Here you can access the Frequently
Asked Questions (FAQs) by clicking the Product Support button in the lower left corner of the home page.

Before contacting technical support with a problem, be sure you have done the following:

Followed the Install Guide completely
Read this ReadMe file completely

Have checked the website for any updates
Have downloaded and installed any updates

When contacting technical support, be sure to include the following information:

Your Operating System (Window 95, 98, ME, XP, 2000 and so on)

The exact name of the product (TV Slideshow Studio)

Registration code (found on the registration card)

Include any and all error messages reported or provide a step-by-step procedure to re-create the problem.
If it is a visual problem, describe the screen with as much detail as you can.

Please do not send attachments unless permission is granted ahead of time. If screen-shots are required, please
keep them as small as possible (100KB or less) in JPG format. If your problem has not been addressed, or if you
would like to send any comments on TV Slideshow Studio, send an e-mail to tech@abacuspub.com and our
support team will respond as soon as possible.
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